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In this session, we'll look at some ways to enhance the communications value of
your slides and some tips to avoid humiliation.

The standard presentation software for most scientific talks is MS PowerPoint. Like
it or hate it, that’s what nearly all AV systems at conferences are set up to use. If
you are determined to be an iconoclast and use some other presentation software,
fine, but be prepared for last-minute technical difficulties that will annoy your
colleagues and cut into your presentation time. If you demand to use something
other than PPT, take along a PDF version of your talk on a memory stick that you

can use when the computer in the seminar room can’t run Photoshop or
LibreOffice.

Alexei Kaptarev’s Death by Powerpoint is an Internet classic not to be missed:
http://www.slideshare.net/thecroaker/death-by-powerpoint/
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| recommend turning off the “bullet list” format, which is the default in PPT. Presenting
ideas in bulleted lists implies hierarchies or relationships that may not, in fact, exist.

“Lists can communicate only three logical relationships: sequence (first to last in time),
priority (least to most important, or vice versa), or simple membership in a set (these
items relate to one another in some way, but the nature of that relationship remains
unstated). A list can show only one of those relationships at a time.” Gordon Shaw,
Robert Brown, Philip Bromiley, “Strategic Stories: How 3M is Rewriting Business

Planning,” Harvard Business Review 76, 42—44 (1998).

Turning off the bullets also gives you more slide real estate to work with.
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The default for PowerPoint slide “titles” is centered. Change it to left-justified.

Turn off the automatic “fitting” functions in PPT to avoid having PPT reduce your
font size if you exceed the number of characters MS thinks you should have on a
line.

In PPT 2003, on the “Tools” menu, click on the “AutoCorrect Options” tab, then
select “Autoformat as you type” tab, and uncheck the two “AutoFit” options in the

Repiace the content-iess PPT “titie” with a

meaningful motivating statement
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Tip 1: Write the statement as a sentence and left-justify it

Tip 2: Turn off the “auto-correct” feature in PPT that reduces
the font size if you exceed the number of characters that MS

thinks you should have in a title

“Apply as you type” list.

In PPT 2010, right click inside the text box, then select “Format Shape” from the
drop-down menu. In the dialogue box, click on “Text Box” on the left navbar, and

then turn on the “Do not Autofit” radio button in the “Autofit” section.
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Choose an easy-to-read font (40 pt)

Make sure your audience (36 pt)
Can easily read (32 pt)

" = ‘ 2

See what | mean? (14p

Tip: The bigger the room—the bigger the font

You can use the “Master Slide” to format text on all slides. To get to the master
slide in PPT 2003, click Shift+the slide icon in the lower left corner of the
workspace, or use the “View” menu. To get out of “master slide” view, click

CRTL+ the slide icon.

To get to the master slide in PPT 2010, click Shift+the slide icon in the lower
right corner of the workspace, or use the “View” ribbon. To get out of “master

slide” view, click CRTL+ the slide icon.
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Calibri Tahoma
Helvetica Corbel

Use a simple sans serif font °“ (...

Serif fonts don’t project as well, because the
narrow parts tend to fade away

Eschew miM foseta (including Comic Sans*)

Use one main font color and, at most,
one contrasting font color for emphasis

Use one main font and, at most, one
contrasting font for emphasis

Use mixed upper and iower case for text—
WRITING IN ALL CAPS LOOKS LIKE YOU'RE
SHOUTING (and it’s much harder to read—and

proofread!) *or risk professional ridicule

Keep text to a minimum—use just enough words to orient the audience to what
they are seeing. You want them to be listening to you, not reading a novella off
the screen.

Do as | say, not as a do. This slide, while typical of an academic lecture to
facilitate note-taking, has w-a-a-a-a-a-y too much text on it for a science talk.
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your computer

ifferent computer—Voila! Pencils!
[ |

conference computer

Every computer has its own individual “library” of fonts; if PPT cannot find a font
when you open your presentation on a different machine, it just arbitrarily
substitutes a font that it thinks is “close.” Often, it isn’t...

© 2016 Board of Trustees of the University of Illinois

All rights Reserved

6/16/2016



PowerPoint Tips for Science Talks 6/16/2016
Celia M. Elliott

PPT can “embed” your fonts in the file,
but you have to tell it to do it every time

conference computer

Professor DeMarco’s tip: Create your
equation in LaTex, save it as a .png, and
insert the image in your PPT slide

To embed fonts in your PPT file:

(1). Open the document in PowerPoint

(2). Click on the “File” tab on the ribbon

(3). Click on the “Options” link on the left menu
(4). Click on the “Save” link

(5). Locate “Embed fonts in the file” option at the
bottom of the dialogue box

(6). Click in the check box to turn on the option

© 2016 Board of Trustees of the University of Illinois
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Choose a neutral background and a high-
contrast color for the text

This isn’t high-enough contrast

Be aware that colors that look bright and crisp on your monitor may look entirely
different when projected. In particular, pastel colors and thin lines fade away. Use

bright, primary colors, bold fonts, and thick lines.

© 2016 Board of Trustees of the University of Illinois

All rights Reserved

6/16/2016



PowerPoint Tips for Science Talks
Celia M. Elliott

Don’t use photographic or “fill”
backgrounds

They make your text too
hard to read

Even if it’s about
hydrophobic

it looks really cool
materials 433550055230353000052%:

Even if \,f_di; think

Don’t use photographic or textured backgrounds—just don’t do it. They’re

distracting, they get boring after you’ve seen the first one, and the superimposed

text is often impossible to read on them.
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Don’t use one of the PPT templates

They take up too much real estate with
meaningless graphics
They force you to devote 25% of the slide to
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You want the audience to be thinking about what you’re saying and looking at the
evidence you’re presenting, not swooning (or snickering) over your artistic taste.
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Don’t use red or green to convey
important information*

J' g ] 4 d QJ‘I

Development of turbulencein a soap film as its surface is raked
by a wire comb. Courtesy Nigel D. Goldenfeld

*Between 8 and 12 percent of white males are red-green
colorblind—who’s your audience?

6/16/2016

If you use color to convey information, make sure that information transfers as you intended

it and is accessible to everyone in your audience.

Another good resource is http://www.colourblindawareness.org/colour-blindness/.
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Be sure the audience sees what you see*
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*Check your images on a free color-blindness simulator:
http://www.colblindor.com/coblis-color-blindness-simulator/

To see what your image will look like to someone who is color blind, upload your
image to the free emulator at http://www.color-blindness.com/coblis-color-
blindness-simulator/.

Another great resource, including step-by-step instructions for labeling fluorescent
microscope images and data plots so they can be distinguished by colorblind
people:

http://jfly.ilam.u-tokyo.ac.jp/color/.

© 2016 Board of Trustees of the University of Illinois
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To make a line break without starting a new item, press Shift+space bar. Don’t maroon a

Use manual line breaks so that the text is
not interrupted in awkward places

=SPring-8: electron
storage ring for
synchrotron radiation, 8
GeV

®"LEPS = Laser Electron
Photon beam @ SPring-
8

"Compton back scatter
351 nm Ar (UV) laser
photons off electrons
=*produces 1.5-2.4

GeV photon beam

Avoid big empty _
spaces, too

number at the end of a line and put the unit on the next line!

6/16/2016

Use the “Order” command on the “Draw” toolbar in PPT 2003 to arrange text and figures in

layers. In PPT 2010, right click on the item you want to arrange and then click on the arrow

to the left of the “Send to Back” or “Bring to Front” options to arrange layers.

Extra text boxes don’t cost anything. You can use more than one on a slide.
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Here’s how to do a slide make-over

*SPring-8: electron
storage ring for
synchrotron radiation, 8
GeV

="LEPS = Laser Electron

Add an informative
title

Photon beam @ SPring- Show some data!
8
=Compton back scatter ' . . ) '
351 nm Ar (UV) laser SPring-8 “light” is ~1 billion times more brilliant than
photons off electrons conventional X-ray sources
=produces 1.5-2.4 o et 2 ;
GeV photon beam | Ve
! — |
Position important | e
info strategically | S oo s ammeame s btvsnsGol sectos s
SPring-8: Storage ring for 8-GeV synchrotron radiation
Maximize your Compton back scatters 351-nm Ar (uv)

laser photons off electrons
Produces 1.5-GeV-2.4-GeV photon beam

Use short captions to orient the viewer immediately

slide real estate

Here’s how | would improve the previous slide.

¢ Add a motivating statement at the top of the slide.

* Make the obligatory aerial photo of the accelerator smaller and stick it at the lower right of the slide, to
convey to the audience that the image is not important.

¢ Turn off the bullets and tighten up the prose to reduce the number of lines of text.

¢ Use the additional space you’ve freed up to show a cartoon of the physical process, a schematic of the
beamline, and the energy spectra of the photons, and put those images at the top of the slide to
emphasize them.

6/16/2016

If you just have to show the obligatory aerial photo of the accelerator, make it smaller, move it off center-
stage, and crop to emphasize the ring, not the surrounding countryside. A scale would be really nice, but
although | found 48 different aerial photographs of SPring-8 on the Internet, not one showed how big it is.
A label superimposed on the photo that shows where LEPS is located on the ring would be a good

addition, too.

Some technical-editing changes:

* A hyphen is required between 8 and GeV in the first line, 351 and nm in the second line, and 1.5 and
GeV and 2.4 and GeV in the last line of text. In every case, the number is combined with the unit to
make an adjective that describes the size of the following noun; you indicate that it’s an adjective by
hyphenating the two components.

¢ The abbreviation for “ultraviolet” (and infrared) is always written lower case.

¢ Provide both lower and upper units for numbers in a range.
¢ Indicate a range by an en dash, not a hyphen.

Images taken from http://www.rcnp.osaka-u.ac.jp/Divisions/np1-b/lepsbl.html.
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Use PPT animation to control the
audience’s attention while you’re speaking

Spring-8 “light” is =1 billion times more brilliant than
conventional X-ray sources

= i BLLER
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Differential cross sections for the BCS process

Schematicview of the LEPS beamlineand the Compten
between 8-GeV electrons and laser photons

backscattering process

Spring-8: Storage ring for 8-GeV synchrotron radiation

Compton back scatters 351-nm Ar (uv) laser -
off electrons

Produces 1.5-GeV-2.4-GeV photon beam

When you present an audience with a complicated slide like this one, they don’t know what
to look at first and they try to look at everything instead of listening to you. Control their
attention by using animations to present bits of information one at a time, synchronized with
what you are saying.

Using animations requires practice and rehearsal—we’ve all forgotten about an animation
and then were surprised when something popped up when we were expecting that click to
bring up the next slide. (And we always give it away by mumbling “Oops, | forgot about
that...”)

Mark up your “notes” pages to indicate animations so you can keep track of them as you are
speaking.
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You can “build” slides in one of two ways

Use PPT animation Create multiple slides*
(L learning curve) s o s e

e . e DEsich Spring 8- Starage ring for 8 GaVl tynchsotron radiation
Ik INSER ESIGN Compton back scatters ¥51-nm Ar {w) laver T
= S

Produces 1.5 GeV-2.4-GoV photon bram

T4 Animation Pane Reorder Ansmatio Spring-8 “light” is =1 billion times more brilliant than
conventicnal X-ray sources

- B-GaV mymchestran radiation
Compton back 1atters $51-nm Ar (] laser
oft abectroms - |

Spring-8 “light” ks =1 billion times more beillant than
conventional X-ray sources

* % % ¥

*Use the “Insert Duplicate Slide” T,
2 Compton back scatters ¥51-mm Ar fuv) laser
tool for smooth builds o e E

The animation tool gives you more control and offers a variety of special effects.
However, like anything else, there’s a learning curve associated with it, and you’ll have
to invest time to get good at it.

Creating multiple slides is easier—at least initially—and extra slides don’t cost a dime.
For best results, do the first, stripped down slide, and then use the “insert duplicate
slide” tool to make each subsequent slide. That way, you don’t have slight variations
in the position of text and figures (which is distracting and annoying for the audience)
when you switch from one slide to the next.

On the main toolbar in PPT, click on the “Insert” tab.

When the “Insert” ribbon comes up, click on the down arrow on the “New Slide” icon
(first one on the far left), and scroll to the bottom of the menu to “Duplicate Selected
Slides” and click on it. (I have no idea why MS uses this language; when you click on
that item, PPT inserts a duplicate of the slide you are on—you cannot “select” multiple
slides. <sigh>)
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Technology presents its own challenges

Seminar and conference rooms are increasingly
being outfitted with plasma monitors instead
of projector screens

Laser pointers don’t
work on plasma

screens

Use a dark background and the cursor to point

Add animated arrows to your slide to point out
important features

You could point out features with your hand, but the monitors are often
mounted on the wall across the room, above your head, or behind you, where

you cannot easily reach them without really hopping around and distracting the
audience.

Don’t try to use your laser pointer and then say, “Huh! The laser pointer doesn’t
work. Wow! Now what do | do? Well, | guess you can see what | mean...”
USE THE MOUSE TO MOVE THE CURSOR and hope most people can see it.

© 2016 Board of Trustees of the University of Illinois
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To recap:
Turn off the bullets

Use motivating statements at the top of your
slides, not bland, generic “titles”

Choose a neutral background
Use a sans serif font, at high contrast to the

background, big enough to see from the back
of the room

Embed your fonts!

....... judiciously

Use animations to control the audience’s
attention N 38 SN 3

Keep up With techn°|ogy cmelliot@illinois.edu

http://physics.illinois.edu/people/Celia/

Notes and Questions:
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